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Мастеринг. Master Mixer Track


"Мастеринг" – как много в этом слове, но пока я хочу объяснить всего лишь концепцию обработки трэка в мастер секции (на канале Master). 


Историческая справка:
Как уже было сказано, в понятие "мастеринг" входит выравнивание всех записей по громкости, частотное балансирование, разметка носителя, но это больше относится к изданию демо-диска и как следствие - мастеринг - это работа не с одним треком.

Скажем так: делая мастеринг – работаем с треком, оглядываясь на другие треки альбома и на трек-эталон. Как правило, самим мастерингом занимаются в таких программах как Adobe Audition или WaveLab, так как периодически загружать то один, то другой трек во Фрутик неудобно и неудобно их сравнивать между собой. 
Но если, например, вам надо довести один трэк до коммерческой кондиции, чтобы отправить на радио или выложить в Интернет, тогда делают премастеринг.

Премастеринг – это как раз то, чем занимаются на конечном этапе изготовления отдельного трэка. Это то, что заставляет звучать ваше произведение серьезно на разных акустических системах и адекватно доноситься при радио трансляции.


Научившись делать премастеринг, вы поймете, как делать мастеринг. Так как средства выполнения одного и другого одни и те же.


Далее по тексту понятие мастеринга и премастеринга будут использоваться как эквиваленты – но не забывайте, что разница все же есть.


Очень важно понимание того, что, работая на канале Master, вы взаимодействуете с треком в целом, и радикально улучшить отдельный компонент его звучания весьма сложно.


Рассмотрим нестандартный и стандартный подход к мастерингу.


1. Нестандартный подход
Вы в миксе используете уже прокаченные по отдельности компрессорами и/или эквалайзерами инструменты, поэтому в целом трэк звучит уже громко. Тогда при сведении в мастер-секции используют лимитер (или клипер), и мастеринг трэка на этом в принципе можно завершить.

Во Фрути Лупсе плагин клипер называется Fruity Soft Clipper (что логично). 

Плагин позволяет отсечь в трэке все, что превышает определенный уровень (как правило, 0 дБ или близкое к нулю значение), таким образом, избавляясь от клиппирования, вы убираете перегрузки.

Если же вы счастливый обладатель Wave Arts Power Suite, то там плагин-лимитер называется FinalPlug, с помощью него можно не только убрать клиппирование, но и дополнительно прокачать трэк по громкости.

Обычно цепочка эффектов на мастер-канале в этом случае следующая:

  



Fruity Soft Clipper
и все…

или такая:

Fruity Parametric EQ
Fruity Soft Clipper

При экспорте применяется дизеринг.


2. Стандартный подход
Вы свели свой трэк, в котором в целом соблюден баланс инструментов, клиппирование отсутствует, и нужна прокачка трека по громкости. Тогда используют особо настроенный однополосный компрессор (Fruity Compressor) или многополосный компрессор (Fruity MultiBand Compressor), или максимайзер.

После обработки компрессором применяется жесткий ограничитель (лимитер или клипер), чтобы избавиться от любого превышения 0 дБ. Многие компрессоры скрыто используют лимитер, таким образом, что сигнал из них практически никогда не превышает 0 Дб (например, Fruity Compressor, F S Comp).

Обычная цепочка эффектов на мастер-канале в этом случае следующая:

  



Fruity Compressor
и все…

или:

Fruity Compressor 
Fruity Parametric EQ
Fruity Soft Clipper

или:

Fruity MultiBand Compressor (с включенным лимитером)

или:

Fruity MultiBand Compressor (с отключенным лимитером)
Fruity Parametric EQ
Fruity Soft Clipper


или такая:
Wave Arts Power Suite MultiDynamics
Wave Arts Power Suite FinalPlug

При экспорте во всех примерах кроме последнего применяется дизеринг. В последнем примере включается болк дизеринга в Wave Arts Power Suite FinalPlug.

профессионалы не советуют…


Почему не советуют использовать однополосный компрессор при мастеринге? 

Дело в том, что, как правило, перегрузки, на которые реагирует (срабатывает) компрессор, дают басы. То есть при перегрузках в басах могут быть обделены в громкости верха, а это, как правило, не является желаемым эффектом (если вы не Benny Benassi). 

Так вот иногда даже правильная настройка параметров компрессора (атака, спад в частности) не дают желаемого результата, и при присоединении басов в линию остальные инструменты “зажимает”. 

В таких случаях используют многополосный компрессор, где каждая частотная полоса имеет свои настройки компрессии.

В FL Studio 6 появился многополосный компрессор – когда я его впервые увидел, то сразу понял, что это “фруктовая версия” C3 Multi Band Compressor от slim slow slider. Спешу заметить, это одни из лучших многополосных компрессоров, которые распространяются бесплатно – этим он и хорош, а качество звучания на выходе относительное.

Если выбирать между однополосным Fruity Compressor и многополосным Fruity MultiBand Compressor – лучше последний.

Использование лимитера/клипера


Все же стоит объяснить различие между лимитером и клипером. 

Лимитер это фактически компрессор с высоким коэффициентом сжатия и малым временим атаки. Например, настройки компрессор предназначенного для мастеринга как лимитера будут выглядеть следующим образом: время атаки = 3 мс, порог срабатывания = -0.1 dB, степень сжатия = 30:1, тип Soft. Клипер же просто отбрасывает часть сигнала превышающего порог. 

A. Fruity Soft Clipper – его следует использовать в мастер секции, когда нужно просто избавиться от клиппирования, не прокачивая по громкости микс. В настройках плагина всего две ручки: threshold и post gain. Post gain рекомендую не трогать. Threshold надо отрегулировать по вкусу: значение немного увеличивают, если самое громкое место в треке звучит зажато. 

B. Wave Arts Power Suite FinalPlug
Это плагин представляет собой лимитер/максимайзер + блок дизеринга.
Лимитер имеет три параметра:
Thresh (порог), Ceiling (потолок) и Relese. Время атаки и lookahead фиксированы и равны 1.5 ms.

Работу плагина можно описать в двух словах следующим образом. Сигнал, превышающий Thresh, будет прокачиваться до уровня Ceiling. Сам параметр Ceiling определяет максимально возможную громкость. Таким образом, уменьшая Thresh и увеличивая Ceiling – мы прокачиваем микс по громкости, а если Thresh = Ceiling, тогда плагин работает просто как жесткий ограничитель.

Для подвижной музыки, в общем случае подойдут следующие параметры:
Tresh = -4 dB, Ceiling = -0.1 dB, Release = 100-300 ms.

С. Эффект Hard Limiting в программе Abobe Audition (Cool Edit)
Этот эффект может увеличивать уровень сигнала, а затем убирать возникшее клиппирование.

1. Экспортируем в wav наш трэк в наивысшем качестве (32bit float 18.8) без дизеринга.

2. Открываем файл в Adobe Audition, выделяем файл целиком, затем Analyze > Statistics... Сколько там не хватает до среднеквадратичной мощности Average RMS Power = -12? (точнее, RMS – это среднеквадратичное значение уровня сигнала)

3. Допустим у нас Average RMS Power = -13 dB, надо получить хотя бы -12 dB.
4. Усиливаем звук и убираем перегрузки: Effects > Amplitude > Hard Limiting…
5. Limit max amplitude to = -0.1 dB; Boost input by = 1 dB; Look ahead time = 7ms; Release = 100-150 ms
5. Analyze > Statistics... – результат на лицо, осталось послушать и решить, сделали мы звук лучше или хуже. 

Поподробнее про пункт 2. Использование компрессора


A. Использование Fruity Compressor
Критерием правильности подбора параметров компрессора является звучание самых громких и самых тихих пассажей в треке, если они звучат естественно, тогда все сделано правильно.


Итак, для общего микса выбираются значения, которые были представлены выше в таблице Compressor Settings, инструмент - mix.
Время атаки = 0-3 мс. Степень компрессии 3:1. 

Порог (threshold) изначально надо установить в -6 Дб, затем более точно отрегулировать, исходя из того утверждения, что столбики Дб метра должны колебаться свободно между -6 и 0 Дб. 

Затем, увеличивается значение Gain так, чтобы отметки колебались между -4 и 0 Дб. 

Сильно компрессированная запись звучит малоподвижно, несмотря на высокую громкость. Поэтому надо находить компромисс между динамической подвижностью трека и его громкостью. Если потом готовый трэк вы проанализируете в каком-нибудь звуковом редакторе, например, Adobe Audition, и средняя мощность (точнее, среднеквадратичное значение уровня сигнала) Average RMS Power будет больше -12 dB, а общая мощность Total RMS Power больше -10 dB – значит, имеет место говорить о нормальной мощности трэка. 

B. Использование C3 Multi Band Compressor
Точная и правильная настройка плагина позволит вам легко разогнать среднюю мощность трэка до -11 Дб.

Если подумать логически, то можно понять какой инструмент отвечает за конкретную частотную полосу и взять средние параметры компрессии из таблиц, приведенных выше для однополосного компрессора.


Тип компрессора для всех полос кроме Low надо установить на Soft.
Для Low устанавливается значение близкое к Hard.
Тип фильтра разделения полос (filter type)- LinearPhase filter.
Лимитер должен быть включен, если не предполагается дальнейшей обработки. 

Параметрический эквалайзер в мастер секции


С одной стороны – весьма сомнительная вещь при использовании во Фрути Лупсе.

Перед тем как ставить эквалайзер на мастере, подумайте, а что я хочу сделать, какую проблему я хочу решить.

Затем подумайте, из-за каких компонентов возникла эта проблема, и постарайтесь ее решить на уровне отдельных каналов микшера.

Я считаю, параметрические эквалайзеры на отдельных каналах, для отдельных инструментов это более расчетливый подход. 

Все же если вы решили использовать эквалайзер в мастер секции, примите в учет следующие сведения: 

30-300 Гц – Увеличение в этой полосе прокачивает бас в целом.

330-800 Гц – Уменьшение в этой полосе устраняет мутность микса.

800-1200 Гц – Увеличение дает субъективное увеличение громкости.

1200-5000 Гц – Прибавление на полосе увеличивает громкость, добавляет так называемое “присутствие” (presence). Вообще если взять частоты 3000, 5000, 7000 Гц, для них выбрать полосу пропускания (band width) близкую к единице, затем повысить уровень на 2, 3, 4 дБ соответственно, то получится такое звучание, как если бы трэк делали в программе Propellerheads Reason.

Иногда поступают следующим образом: на 1300 Гц меняют тип фильтра с Peaking на High shelf, и повышают уровень на пару дБ, затем повторяют предыдущий трюк с 3, 5, 7 кГц.

5000-7000 Гц – Увеличение в этой полосе повышает четкость, делает звук ярким, однако слишком сильная прокачка портит микс, делая его назойливо шипящим.

7000 Гц и выше – подъемы в этой области могут увеличить четкость. 
Еще один повод использовать эквалайзер описан ниже в разделе “последовательность использования плагинов на мастер-канале”


Замечание:
После того как вы сделали желаемые изменения, отключите эквалайзер и послушайте, действительно ли вы сделали звучание лучше.
Замечание:
В некоторых эквалайзерах вместо полосы пропускания используется понятие добротность фильтра, что есть отношение центральной частоты к частоте пропускания. Обозначается одной буквой “Q”.
Замечание:
Много интересного написано на тему эквализации в книге Д. Гибсона “Искусство сведения” (на русском). Так же можно поискать статью “RECOMMENDED EQUALIZATION FREQUENCIES” by Robert Dennis (in English).
Как насчет радио


Едва ли вы представляете, скольким преобразованиям подлежит ваш трек во время трансляции. По этой теме есть много литературы, в основном на английском языке.

Но вопреки убеждениям, особых приготовлений не требуется.

В записи не должно быть резких спадов ниже -6 дБ. Не должно быть длительных всплесков громкости близких к 0 дБ. 

Компрессор на радио станции будет повышать все что ниже -6 Дб и наоборот убирать излишки перекомпрессированной записи. Плагин FinalPlug из Wave Arts Power Suite идеально подходит для обработки радио трэка.

Пару слов про dithering 


Дизеринг (иногда произнося как дитеринг) – это способ сгладить слышимые ошибки квантования при конвертировании аудио данных с более высоким разрешением в менее высокое. Например, из 24 бит в 16. 

Эта весьма сложная тема, но на пальцах объяснить ее можно.
Например. При преобразовании из 24 бит в 16 (стандарт CD Audio) из 24 битной записи отбрасываются 8 младших бит (24-8=16), поэтому ухудшается качество записи. Такое отбрасывание называется транкейтом (truncate - срезать верхушку, усекать)

При использовании дизеринга, перед транкейтом к сигналу подмешивается небольшое количество шума, с целью перенести больше полезного сигнала в старшие 16 бит.

Затем отбрасываются 8 младших бит, небольшое количество шума остается, но искажения от транкейта становятся не такими слышными.

Ноиз-шейпинг (noise shaping) – это улучшенная технология дизеринга, много про нее уже написано. Общий смысл заключается в том, что шум добавляется в диапазоне, к которому человеческое ухо менее критично.

Вот, собственно говоря, все про дизеринг. Профессионалы-математики и корифеи психоакустики могут закидывать меня помидорами.

Когда и как применять дизеринг?

1. Дизеринг должен применятся к звуковому файлу однократно.


2. Поскольку плагины и генераторы FL Studio работают с более чем 16 битной математикой, имеет смысл говорить о применении дизеринга, в том случае, если не предполагается дальнейшего преобразования материала пред записью на диск.


3. Чем тише место в треке, тем сильнее слышен результат применение дизеринга, хотя стрёмно говорить о слышимости, когда добавляется столь мизерное количество шума.


4. Мне очень нравилась надпись, которая раньше появлялась в окне подсказки при наведении курсора на рубильник дизеринга в окне экспорта. “May improve quality, if you believe in dithering” – дословно: “Может улучшить качество, если вы верите в дизеринг”… Прикольно.

Важно: последовательность использования плагинов на мастер-канале 


Рекомендуется соблюдать следующую последовательность:

1. Компрессор
2. Эквалайзер
3. Лимитер
4. Дизеринг (всегда применяется последним и однократно) 

Как правило, после компрессии, несмотря на повышение общего уровня сигнала, высокие частоты становятся беднее. 

Поэтому в случае использования компрессора, после него ставят эквалайзер или энхансер, который восстанавливает высокие частоты. 

После эквалайзера ставят лимитер. В случае использования многополосного компрессора помогает увеличение атаки для верхней полосы.
Следует заметить, что даже уменьшение эквалайзером громкости какой-нибудь частоты может привести к клиппированию сигнала (это не очевидно). Сие утверждение требует математического доказательства, примите его как должное или проверьте на практике.

Полезные плагины не от FL Studio


Wave Arts Power Suite (VST, DX, RTAS) – набор плагинов, среди которых есть хорошая реверберация и многоканальный компрессор. Также есть продвинутый лимитер.

Steinberg DaTube (VST) – эмулятор ламповой насыщенности. Делает сигнал теплым, добавляя к нему модные “аналоговые” шипы. Есть смысл использовать его на басовых инструментах в качестве лимитера.

mda Stereo (VST) – стерео симулятор. Использует Comb filtering (фильтр-расческа, когда общий спектр сигнала делится между правым и левым каналом) и Haas panning (эффект Хааса он же эффект предшествования, подробнее в книге Пола Уайта “Творческая звукозапись”). Плагин можно успешно использовать для узко звучащих инструментов, бэк-вокала. При обработке эффектом бас линии, получается звучание характерное для стиля deep house.

F S Comp (Fraser Stuart Stereo Valve Compressor, VST) – однополосный VST компрессор, очень похож по параметрам и звуку на Fruity Compressor – хорошая альтернатива, да и в других редакторах с ним привычней работать.

W1 (George Yohng W1 Limiter, VST) – лимитер/максимайзер. Автор его называет L1 Clone, понятно почему – похож, по сути, на плагин от Waves, только этот меньше и бесплатный. Блок дизеринга отсутствует.

VST to DirectX Adapter (DX) – используем любимые VST в прогах, которые поддерживают только DX плагины.

Кое-что вы сможете найти на этом сайте в разделе Скачать.

